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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product description

Category Description HP Mini 311 Compaq Mini 311 HP Pavilion dm1

Processors Intel® Atom™ N280 1.66-GHz, 512-KB L2 
cache, 667-MHz front-side bus (FSB)

Intel Atom N270 1.60-GHz, 512-KB L2 
cache, 533-MHz front-side bus (FSB)

Intel Pentium® SU4100 1.3-GHz, 2048-KB 
L2 cache, 800-MHz front-side bus (FSB)

Intel Mobil Celeron® SU2300 1.2-GHz, 
1024-KB L2 cache, 800-MHz front-side 
bus (FSB)

Chipset MCP79

Intel GS45 (8W)

Southbridge ICH9M

Graphics nVidia ION (Windows 7 only)

nVidia ION LE (Windows XP only)

Intel UMA graphics (Mobile Intel GMA 
X4500 HD) Integrated with shared video 
memory:

■ Up to 270-MB for 1024-MB 
system RAM

■ Up to 319-MB for 1024-MB 
system RAM

■ Up to 782-MB for 2048-MB 
system RAM

■ Up to 895-MB for 2048-MB 
system RAM

■ Up to 1294-MB for 3072-MB 
system RAM

■ Up to 1294-MB for 4096-MB 
system RAM (32 bit OS)

■ Up to 1407-MB for 3072-MB 
system RAM

■ Up to 1759-MB for 4096-MB 
system RAM (64 bit OS)

Support for BD and HD-DVD playback 
with HD decode and DX10.1 support

(Continued)
Maintenance and Service Guide 1–1



Product description
Panel 11.6-in (1366 × 768) HD, BrightView, LED 
display assembly, supports privacy filter

Memory 1024-MB on-board memory and one 
customer-accessible/upgradable memory 
module slot
Supports dual-channel memory
Supports the following DDR3 
configurations at 1333 MHz:

■ 5120-MB total system memory (1024 
on-board memory + 4096, dual 
channel)

■ 3072-MB total system memory (1024 
on-board memory + 2048, 
dual-channel)

■ 2048-MB total system memory (1024 
on-board memory + 1024, 
dual-channel)

■ 1024-MB total system memory (1024 
on-board memory, dual-channel)

Supports the following DDR3 
configurations at 1066 MHz:

■ 5120-MB total system memory (1024 
on-board memory + 4096, dual 
channel)

■ 3072-MB total system memory (1024 
on-board memory + 2048, 
dual-channel)

■ 2048-MB total system memory (1024 
on-board memory + 1024, 
dual-channel)

■ 1024-MB total system memory (1024 
on-board memory, dual-channel)

Solid-state drive Supports 80-GB solid-state drive

Hard drives Supports 9.50-mm, 6.35-cm (2.50-in) 
hard drives
Supports HP ProtectSmart 
Hard Drive Protection
Customer-accessible
Serial ATA (SATA)

Supports the following hard drives:

■ 500-GB, 5400-rpm

■ 320-GB, 5400-rpm (Windows 7 only)

■ 250-GB, 5400-rpm (Windows 7 only)

■ 160-GB, 7200-rpm

■ 160-GB, 5400-rpm

(Continued)
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Product description
Optical drives 12.7-mm tray load external USB optical 
drive
Serial ATA (SATA)
Customer-accessible
Supports no-optical-drive option

Supports the following drives: 

■ Blu-ray ROM with LightScribe 
DVD±R/RW and CD-RW SuperMulti 
Double-Layer Drive

■ DVD±RW and CD-RW SuperMulti 
Double-Layer Drive with LightScribe

Diskette drive Supports external USB drive only
Supports boot from USB device

Microphone Integrated dual-array digital microphone 

Audio 2 integrated HD stereo speakers
Headphone jack
Microphone jack

Webcam Integrated 2.8-megapixel camera with 
fixed focus

Modem Supports external USB modem option

Ethernet Integrated Realtek10/100 network 
interface card (NIC)
Ethernet cable not included

(Continued)
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Product description
Wireless Integrated wireless local-area network 
(WLAN) options through Mini PCI module:

■ 802.11a/b/g/n WLAN module

■ 802.11a/b/g/n WLAN/ Bluetooth® 
combo module

■ 802.11b/g WLAN module

■ 802.11b/g WLAN/ Bluetooth combo 
module

Supports no-WLAN option

2 WLAN antennas built into the display 
assembly

Integrated wireless wide-area network 
(WWAN) option through Mini PCI module:
WWAN security provided by subscriber 
identity module (SIM), user-accessible 
behind battery
2 WWAN antennas (worldwide, 5-band) 
built into the display assembly
Does not support WWAN aftermarket 
option

Integrated wireless personal area network 
(WPAN) options through Bluetooth® 
module

External media 
cards

One ExpressCard slot, supporting optional 
ExpressCard/34 cards
Digital Media Slot supporting the following 
optional digital card formats:
■ Memory Stick (MS)
■ Memory Stick Pro (MS/Pro)
■ MultiMediaCard (MMC)
■ Secure Digital High Capacity (SDHC) 

Memory Card
■ xD-Picture Card (XD)

Ports Audio-in (stereo microphone)/Audio-out 
(stereo headphone)
HDMI v.1.3
AC power
RJ-45 (Ethernet, includes link and activity 
lights)
USB v. 2.0 (3)
VGA (Dsub 15-pin) supporting 1600 × 
1200 external resolution at 75 GHz

Keyboard/
pointing devices

Spill-resistant keyboard
TouchPad with TouchPad buttons
Touch-sensitive controls
Supports 2-way scroll with legend
Taps enabled by default 

Power 
requirements

65-W AC adapter
6-cell, 2.55-Ah (55-Wh) Li-ion battery

(Continued)
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Product description
Security Security cable slot

Operating system Preinstalled:

■ Free DOS (Windows 7 only)

■ Windows® 7 Professional 32

■ Windows 7 Premium 32

■ Windows 7 Basic 32

■ Windows 7 Starter 32

■ Free DOS (Windows XP only)
■ Windows XP Home Service Pack 3 for 

ULCPC Program

■ Back on Track

Serviceability End-user replaceable parts:
AC adapter
Battery (system)
Hard drive
Memory modules
SIM
WLAN module
WWAN module

Category Description HP Mini 311 Compaq Mini 311 HP Pavilion dm1
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2
External component identification

Display

Display components

Item Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Webcam light On: The webcam is in use.

(3) Webcam Captures still photographs and videos.

✎ To capture videos, you must install additional webcam software.

(4) Internal microphone Records sound.
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External component identification
Wireless antennas

✎ Your computer may look slightly different from the illustration in this section.

To see wireless regulation notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to your 
country or region. These notices are located in Help and Support.

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless local area 
networks (WLAN).

(2) WWAN antennas (2)*
(select models only)

Send and receive wireless signals to communicate with wireless wide-area 
networks (WWAN).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around 
the antennas free from obstructions.
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External component identification
Top components

Buttons

Item Component Description

(1) Power button ■ When the computer is off, press the button to turn on the computer.
■ When the computer is on, press the button briefly to initiate the Sleep state 

or Standby.
■ When the computer is in the Sleep state or Standby, press the button 

briefly to exit.
■ When the computer is in Hibernation, press the button briefly to exit 

Hibernation.
If the computer has stopped responding and operating system shutdown 
procedures are ineffective, press and hold the power button for at least 
5 seconds to turn off the computer.

✎ This describes factory settings. For information about changing factory 
settings, refer to the user guides located in Help and Support.

(2) Wireless button Turns the wireless feature on or off but does not create a wireless connection.

✎ To establish a wireless connection, a wireless network must already be 
set up.
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External component identification
Keys

✎ Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Lights

Item Component Description

(1) Caps lock light On: Caps lock is on.

(2) Power light ■ On: The computer is on.
■ Blinking: The computer is in the Sleep state or Standby.
■ Off: The computer is off or in Hibernation.

(3) Wireless light ■ On: An integrated wireless device, such as a wireless local area network 
(WLAN) device and/or a Bluetooth® device, is on.

■ Off: All wireless devices are off.
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External component identification
Pointing devices

Item Component Description

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) Right TouchPad button* Functions like the right button on an external mouse.

(4) TouchPad scroll zone Scrolls up or down.

*This table describes factory settings.
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External component identification
Front components

Item Component Description

(1) Speakers (2) Produce sound.

(2) Battery light ■ On: A battery is charging.
■ Blinking: A battery that is the only available power source has reached a 

low battery level. When the battery reaches a critical battery level, the 
battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

(3) Drive light Blinking: The hard drive or flash drive is being accessed.
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External component identification
Right-side components

Item Component Description

(1) Digital Media Slot Supports the following optional digital card formats:
■ Memory Stick (MS)
■ Memory Stick Pro (MS/Pro)
■ MultiMediaCard (MMC)
■ Secure Digital (SD) Memory Card
■ xD-Picture Card

(2) Audio-out (headphone) jack/Audio-in 
(microphone) jack

Produces sound when connected to optional powered stereo speakers, 
headphones, earbuds, a headset, or television audio. Also connects an 
optional headset microphone.

✎ When a device is connected to the jack, the computer speakers are 
disabled.

The audio component cable must have a 4-conductor connector.

(3) USB ports (2) Connect optional USB devices.

(4) External monitor port Connects an external VGA monitor or projector.

(5) RJ-45 (network) jack Connects a network cable.
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External component identification
Left-side components

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(4) USB port Connects an optional USB device.

(5) HDMI port Connects an optional video or audio device, such as a high-definition 
television, or any compatible digital or audio component.

✎ Depending on your computer model, the computer may include an 
HDMI port or a USB port at this location.
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External component identification
Bottom components

Item Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) Vents (4) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(4) Hard drive bay Contains the hard drive, the wireless LAN module slot, and the memory 
module slot.

Ä To prevent an unresponsive system, replace the wireless module only 
with a wireless module authorized for use in the computer by the 
governmental agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a warning message, 
remove the module to restore computer functionality, and then contact 
technical support through Help and Support.
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s hardware 
components. The part number helps a service technician determine what 
components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, drivers, and 
support for the computer.

(5) Warranty period This number describes the duration of the warranty period for the computer.
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Computer major components
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Illustrated parts catalog
Item Description Spare part number

(1) 11.6-in (1366 × 768) HD, BrightView, LED display assembly (includes webcam, microphone, 2 WLAN antenna 
transceivers and cables, nameplate, and logo):

Display assembly with 2 WWAN antennas for use with the HP Mini 580006-001

Display assembly for use with the HP Mini 580007-001

Display assembly with 2 WWAN antennas for use with the Compaq Mini 580011-001

Display assembly with 2 WWAN antenna for use with the black-colored HP Pavilion 588689-001

Display assembly with 2 WWAN antenna for use with the white-colored HP Pavilion 588690-001

✎ See “Display assembly subcomponents” on page 3-9 for display assembly internal component spare 
part information.

(2) Keyboard (includes keyboard cable):

For use in Belgium 580030-A41

For use in the Czech Republic 580030-221

For use in Demark 580030-DH1

For use in France 580030-051

For use with the HP Mini and Compaq Mini in French Canada 580030-121

For use in Germany 580030-041

For use in Greece 580030-DJ1

For use in Hungary 580030-211

For use in Israel 580030-BB1

For use in Italy 580030-061

For use in Japan 580030-291

For use in the Netherlands 580030-B31

For use in Portugal 580030-131

For use in Russia 580030-251

For use in Saudi Arabia 580030-171

For use in South Korea 580030-AD1

For use in Spain 580030-071

For use in Switzerland 580030-BG1

For use in Taiwan 580030-AB1

For use in Thailand 580030-281

For use in Turkey 580030-141

For use in the United Kingdom 580030-031

For use in the United States 580030-001

(3) Top cover (includes TouchPad button board and cable, and TouchPad board and cable) 580057-001

(Continued)
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Illustrated parts catalog
(4) Power connector (includes cable) 591851-001

(5) Power button board (includes cable) 580058-001

(6) Speakers (include cables) 580064-001

(7) Wireless button board (includes cable) 580060-001

(8) Fan (includes cable) 580061-001

(9) Heat sink assembly (includes replacement thermal material):

For use with the HP Mini and Compaq Mini 580059-001

For use with the HP Pavilion 581758-001

(10) System board (includes processor, 1024-MB base memory, and replacement thermal material):

Includes Intel Atom N280 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-side 
bus (FSB) for use with the HP Mini and Compaq Mini

580000-001

Includes Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side 
bus (FSB) for use with the HP Mini and Compaq Mini

579999-001

Includes Intel Pentium 1.3-GHz processor, 2048-KB Level 2 cache, 800-MHz FSB for use 
with the HP Pavilion

581751-001

Includes Intel Pentium 1.2-GHz processor, 1024-KB Level 2 cache, 800-MHz FSB for use 
with the HP Pavilion

581750-001

(11) RTC battery 580055-001

(12) Multi board (includes USB and RJ-45 ports, and cable) 580066-001

Multi board for use with the HP Pavilion (includes USB and RJ-45 ports, and cable) 591994-001

(13) Digital media assembly (includes cable) 580065-001

(14) Base enclosure (includes 5 rubber device feet) 580054-001

(15) Expansion memory module (1333-MHz, DDR3):

4096-MB for use with the HP Pavilion 581754-001

4096-MB for use with the HP Pavilion in systems that include a WWAN module 581754-002

2048-MB 580017-001

2048-MB, for use with the HP Mini and Compaq Mini in systems that include a WWAN 
module

580017-002

2048-MB, for use with the HP Pavilion in systems that include a WWAN module 591374-001

1024-MB 580016-001

1024-MB, for use with the HP Mini and Compaq Mini in systems that include a WWAN 
module

580016-002

1024-MB, for use with the HP Pavilion in systems that include a WWAN module 591373-001

(16) WWAN module:

HSPA EV-DO WWAN module for use in all countries and regions except 
the People’s Republic of China

483377-002

HSPA EV-DO WWAN module for use in the People’s Republic of China 483377-003

UNDP HSPA EV-DO WWAN mini module 531993-001

(Continued)
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Illustrated parts catalog
(17) WLAN module:

802.11b/g/n WLAN module:

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

518436-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, 
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British 
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape 
Verde, the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, 
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican 
Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, 
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, 
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, 
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, 
Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, 
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the 
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether 
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, 
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of 
China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, 
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, 
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and 
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, 
Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and 
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab 
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, 
Yemen, Zaire, Zambia, and Zimbabwe

518436-002

Intel WiFi Link 5100 802.11b/g WLAN module for use in Pakistan, Russia, and the Ukraine 482957-001

(Continued)

Item Description Spare part number
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802.11a/b/g/n WLAN module:

■ Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, 
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, 
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, 
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, 
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, 
Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South 
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

(Continued)
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Illustrated parts catalog
802.11b/g WLAN module:

■ WLAN/Bluetooth combo card 575920-001

■ Broadcom 4312G 802.11b/g WLAN module in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, 
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

(Continued)
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Illustrated parts catalog
(18) Hard drive (includes hard drive connector and hard drive bracket):

500-GB, 5400-rpm for use with the HP Pavilion 584512-001

500-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591372-001

320-GB, 5400-rpm 580020-001

320-GB, 5400-rpm, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module

580020-002

320-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591371-001

250-GB, 5400-rpm 580019-001

250-GB, 5400-rpm, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module

580019-002

250-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591370-001

160-GB, 7200-rpm 591250-001

160-GB, 5400-rpm 580018-001

160-GB, 5400-rpm, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module

580018-002

160-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591369-001

80-GB solid state drive (SSD) 584513-001

Hard Drive Hardware Kit (not illustrated, includes hard drive connector and hard drive 
bracket)

580024-001

Solid State Drive Hardware Kit (not illustrated) 580023-001

(19) Accessory compartment cover 580056-001

(20) 6-cell, 2.55-Ah (55-Wh) Li-ion battery 580029-001

Item Description Spare part number
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Display assembly subcomponents

Item Description Spare part number

Display bezel (includes hinge covers):

(1a) Hinge covers

(1b) Bezel

■ For use only with the HP Mini 580010-001

■ For use only with the Compaq Mini 580015-001

■ For use only with the HP Pavilion 587312-001

(2) Display panel 580001-001

(3) Display panel/webcam/microphone cable 580003-001

(4) Webcam module 580004-001

(5) Wireless antenna cables 580005-001

(6) Display enclosure:

For use with the HP Mini 580009-001

For use with the HP Mini that includes WWAN 580008-001

For use with the Compaq Mini 580013-001
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Miscellaneous parts

Description Spare part number

65-W AC adapter 417220-001

External USB optical drive:

Blu-ray ROM with LightScribe DVD±R/RW and CD-RW SuperMulti Double-Layer Drive 580026-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 580025-001

HP Mini Messenger Carrying Case for use with the HP Mini and Compaq Mini 588688-001

Mini Sleeve for use with the HP Pavilion 588589-001

Power cord:

For use with the HP Mini and Compaq Mini in Argentina 490371-D01

For use in Australia 490371-011

For use with the HP Mini and Compaq Mini in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the People’s Republic of China 490371-AA1

For use in the United Kingdom and Singapore 490371-031

For use in the United States 490371-001

Rubber Feet Kit (includes 5 rubber device feet and 8 display bezel screw covers) 580062-001

Screw Kit 580063-001
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Sequential part number listing

Spare part number Description

417220-001 65-W AC adapter

482957-001 Intel WiFi Link 5100 802.11b/g WLAN module for use with the HP Mini and Compaq Mini in Pakistan, 
Russia, and the Ukraine

483377-002 HSPA EV-DO WWAN module for use with the HP Mini and Compaq Mini in all countries and regions 
except the People’s Republic of China

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use with the HP Mini and Compaq Mini in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People’s Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use with the HP Mini and Compaq Mini in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom 4312G 802.11b/g WLAN module for use with the HP Mini and Compaq Mini in Canada, 
the Cayman Islands, Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

(Continued)
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504593-004 Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the 
People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, 
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, 
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, 
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the 
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, 
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-001 Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

518434-002 Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's 
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, 
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the 
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South 
Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab 
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, 
Zambia, and Zimbabwe

(Continued)
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518436-001 Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

518436-002 Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the 
People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, 
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, 
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, 
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the 
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, 
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

531993-001 UNDP HSPA EV-DO WWAN mini module

537921-001 Bluetooth card for use with the HP Pavilion

575920-001 WLAN/Bluetooth combo card

579999-001 System board for use with the HP Mini and Compaq Mini (includes Intel Atom N270 1.6-GHz 
processor, 512-KB Level 2 cache, 533-MHz FSB, 1024-MB base memory, and replacement thermal 
material)

580000-001 System board for use with the HP Mini and Compaq Mini (includes Intel Atom N280 1.66-GHz 
processor, 512-KB Level 2 cache, 667-MHz FSB, 1024-MB base memory, and replacement thermal 
material)

580001-001 Display panel

580003-001 Display panel cable

580004-001 Webcam module

580005-001 Wireless antenna cables

580006-001 11.6-in (1366 × 768) HD, BrightView, LED display assembly with 2 WWAN antennas for use with the 
HP Mini (includes webcam, microphone, 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

580007-001 11.6-in (1366 × 768) HD, BrightView, LED display assembly for use with the HP Mini (includes 
webcam, microphone, 2 WLAN antenna transceivers and cables, nameplate, and logo)

580008-001 Display enclosure for use with the HP Mini and HP Pavilion that include WWAN

580009-001 Display enclosure for use with the HP Mini and HP Pavilion 

580010-001 Display bezel for use only with the HP Mini (includes hinge covers)

580011-001 11.6-in (1366 × 768) HD, BrightView, LED display assembly with 2 WWAN antennas for use with the 
Compaq Mini (includes webcam, microphone, 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

(Continued)
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580013-001 Display enclosure for use with the Compaq Mini

580015-001 Display bezel for use only with the Compaq Mini (includes hinge covers)

580016-001 1024-MB expansion memory module (1333-MHz, DDR3) 

580016-002 1024-MB expansion memory module (1333-MHz, DDR2), for use with the HP Mini and Compaq Mini 
with systems that include a WWAN module

580017-001 2048-MB expansion memory module (1333-MHz, DDR3)

580017-002 2048-MB expansion memory module (1333-MHz, DDR2), for use with the HP Mini and Compaq Mini 
with systems that include a WWAN module

580018-001 160-GB, 5400-rpm hard drive (includes hard drive connector and hard drive bracket)

580018-002 160-GB, 5400-rpm hard drive, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module (includes hard drive connector and hard drive bracket)

580019-001 250-GB, 5400-rpm hard drive (includes hard drive connector and hard drive bracket)

580019-002 250-GB, 5400-rpm hard drive, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module (includes hard drive connector and hard drive bracket)

580020-001 320-GB, 5400-rpm hard drive (includes hard drive connector and hard drive bracket)

580020-002 320-GB, 5400-rpm hard drive, for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module (includes hard drive connector and hard drive bracket)

580023-001 Solid State Drive Hardware Kit

580024-001 Hard Drive Hardware Kit (includes hard drive connector and hard drive bracket)

580025-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe external USB optical drive

580026-001 Blu-ray ROM DVD±R/RW and CD-RW SuperMulti Double-Layer Drive with LightScribe external USB 
optical drive

580029-001 6-cell, 2.55-Ah (55-Wh) Li-ion battery

580030-001 Keyboard for use in the United States (includes keyboard cable)

580030-031 Keyboard for use in the United Kingdom (includes keyboard cable)

580030-041 Keyboard for use in Germany (includes keyboard cable)

580030-051 Keyboard for use in France (includes keyboard cable)

580030-061 Keyboard for use in Italy (includes keyboard cable)

580030-071 Keyboard for use in Spain (includes keyboard cable)

580030-121 Keyboard for use with the HP Mini and Compaq Mini in French Canada (includes keyboard cable)

580030-131 Keyboard for use in Portugal (includes keyboard cable)

580030-141 Keyboard for use in Turkey (includes keyboard cable)

580030-171 Keyboard for use in Saudi Arabia (includes keyboard cable)

580030-211 Keyboard for use in Hungary (includes keyboard cable)

580030-221 Keyboard for use in the Czech Republic (includes keyboard cable)

580030-251 Keyboard for use in Russia (includes keyboard cable)

580030-281 Keyboard for use in Thailand (includes keyboard cable)

580030-291 Keyboard for use in Japan (includes keyboard cable)

580030-AB1 Keyboard for use in Taiwan (includes keyboard cable)

580030-AD1 Keyboard for use in South Korea (includes keyboard cable)

(Continued)
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580030-A41 Keyboard for use in Belgium (includes keyboard cable)

580030-B31 Keyboard for use in the Netherlands (includes keyboard cable)

580030-BB1 Keyboard for use in Israel (includes keyboard cable)

580030-BG1 Keyboard for use in Switzerland (includes keyboard cable)

580030-DH1 Keyboard for use in Demark (includes keyboard cable)

580030-DJ1 Keyboard for use in Greece (includes keyboard cable)

580054-001 Base enclosure (includes 5 rubber device feet)

580055-001 RTC battery

580056-001 Accessory compartment cover

580057-001 Top cover (includes TouchPad button board and cable, and TouchPad board and cable)

580058-001 Power button board (includes cable)

580059-001 Heat sink assembly for use with the HP Mini and Compaq Mini (includes replacement thermal 
material)

580060-001 Wireless button board (includes cable)

580061-001 Fan (includes cable)

580062-001 Rubber Feet Kit (includes 5 rubber device feet and 8 display bezel screw covers)

580063-001 Screw Kit

580064-001 Speakers (include cables)

580065-001 Digital media assembly (includes cable)

580066-001 Multi board (includes USB and RJ-45 ports, and cable)

581750-001 System board for use with the HP Pavilion (includes Intel Pentium 1.2-GHz processor, 1024-KB 
Level 2 cache, 800-MHz FSB, 1024-MB base memory, and replacement thermal material)

581751-001 System board for use with the HP Pavilion (includes Intel Pentium 1.3-GHz processor, 2048-KB 
Level 2 cache, 800-MHz FSB, 1024-MB base memory, and replacement thermal material)

581754-001 4096-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion

581754-002 4096-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion in systems 
that include a WWAN module 

581758-001 Heat sink assembly for use with the HP Pavilion (includes replacement thermal material) 

584512-001 500-GB, 5400-rpm hard drive for use with HP Pavilion

584513-001 80-GB solid state drive (SSD)

587312-001 Display bezel for use only with the HP Pavilion

588589-001 12.1-in Mini sleeve for use with HP Pavilion

588688-001 HP Mini Messenger Carrying Case

588689-001 11.6-in (1366 × 768) HD, BrightView, white-colored, LED display assembly with 2 WWAN antennas 
for use with the HP Pavilion (includes webcam, microphone, 2 WLAN antenna transceivers and 
cables, nameplate, and logo)

588690-001 11.6-in (1366 × 768) HD, BrightView, black-colored, LED display assembly with 2 WWAN antennas 
for use with the HP Pavilion (includes webcam, microphone, 2 WLAN antenna transceivers and 
cables, nameplate, and logo)

591250-001 160-GB, 7200-rpm hard drive 

591369-001 160-GB, 5400-rpm hard drive for use with the HP Pavilion in systems that include a WWAN module

(Continued)
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591370-001 250-GB, 5400-rpm hard drive for use with the HP Pavilion in systems that include a WWAN module 

591371-001 320-GB, 5400-rpm hard drive for use with the HP Pavilion in systems that include a WWAN module

591372-001 500-GB, 5400-rpm hard drive for use with the HP Pavilion in systems that include a WWAN module

591373-001 1024-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion in systems 
that include a WWAN module 

591374-001 2048-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion in systems 
that include a WWAN module 

591851-001 Power connector (includes cable)

591994-001 Multi board for use with the HP Pavilion (includes USB and RJ-45 ports, and cable) 

Spare part number Description
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver

■ Phillips P0 screwdriver

■ Phillips P1 screwdriver

■ Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

ÄCAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, 
damage to a drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off 

or in Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 

touching the connector.
■ Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure 

that the optical drive tray is closed.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging 

and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. 
Or, the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy. 

ÄCAUTION: To prevent damage to the computer when you are removing or installing internal components, observe 
these precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in 

this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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Removal and replacement procedures
The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

ÄCAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until they arrive at static-free workstations. 

■ Place items on a grounded surface before them from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground, and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Workstation guidelines

Follow these workstation grounding guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface, and use properly grounded tools and 
equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field service kits 

■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures
This chapter provides removal and replacement procedures. 

There are as many as 49 screws, in 6 different sizes, that must be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s hardware 
components. The part number helps a service technician determine what 
components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, drivers, and 
support for the computer.

(5) Warranty period This number describes the duration of the warranty period for the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. There are 5 rubber feet that attach to the base enclosure in the 
locations shown in the following illustration.

Description Spare part number

Rubber Feet Kit (includes 5 rubber device feet and 8 display bezel screw covers) 580062-001
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Battery

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you. 

2. Slide the battery release latches 1 to release the battery. 

3. Remove the battery 2.

Install the battery by inserting it into the battery bay until you hear a click. 

Description Spare part number

6-cell, 2.55-Ah (55-Wh) Li-ion battery 580029-001
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SIM

✎ The SIM is provided by the end user as a security measure for the WWAN module. The SIM should be removed, 
placed into a static-dissipative container, and then replaced when the computer is reassembled.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7). 

Remove the SIM:

1. Press in on the SIM 1 to release it from the SIM slot.

2. Remove the SIM 2 from the computer.

Install the SIM by inserting it into the SIM slot until you hear a click. 
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WLAN module

Description Spare part number

802.11b/g/n WLAN module:

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

518436-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, 
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African 
Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech 
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El 
Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, 
India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, 
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, 
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, 
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, 
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the 
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, 
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, 
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, 
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, 
Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and 
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the 
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, 
and Zimbabwe

518436-002

Intel Wi-Fi Link 5100 802.11b/g WLAN module for use with the HP Mini and Compaq Mini only 
in Pakistan, Russia, and the Ukraine

482957-001

(Continued)
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Removal and replacement procedures
802.11b/g WLAN module:

WLAN/Bluetooth combo card 575920-001

Broadcom 4312G 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto 
Rico, the United States, and the U.S. Virgin Islands

504593-003

Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, 
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, 
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. 
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, 
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, 
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, 
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, 
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. 
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, 
Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, 
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

Description Spare part number
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Removal and replacement procedures
Before removing the WLAN module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Remove the WLAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Loosen the 2 Phillips PM2.0×6.0 captive screws 1 that secure the accessory compartment cover to 
the computer.

3. Lift the left side of the cover 2 to detach it from the computer, and remove the accessory compartment cover.

✎The accessory compartment cover is available using spare part number 580056-001.
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Removal and replacement procedures
4. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module.

✎The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The white WLAN 
antenna cable is connected to the WLAN module “Aux” terminal. 

5. Remove the Phillips PM2.0×4.0 screw 2 that secures the WLAN module to the system board. (The WLAN 
module tilts up.)

6. Remove the WLAN module 3 by pulling it away from the slot at an angle. 

✎WLAN modules are designed with a notch 4 to prevent incorrect insertion of the WLAN module into 
the WLAN module slot.

Reverse this procedure to install the WLAN module. 
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Removal and replacement procedures
WWAN module

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

Remove the WWAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Disconnect the WWAN antenna cables 1 from the terminals on the WWAN module.

✎The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue WWAN 
antenna cable is connected to the WWAN module “Aux” terminal. 

3. Remove the 2 Phillips PM2.0×4.0 screws 2 that secure the WWAN module to the system board. (The WWAN 
module tilts up.)

4. Remove the WWAN module 3 by pulling it away from the slot at an angle. 

✎WWAN modules are designed with a notch 4 to prevent incorrect insertion of the WWAN module into 
the WWAN module slot.

Description Spare part number

HSPA EV-DO WWAN module for use with the HP Mini and Compaq Mini in all countries and regions 
except the People’s Republic of China

483377-002

HSPA EV-DO WWAN module for use with the HP Mini and Compaq Mini in the People’s Republic 
of China

483377-003

UNDP HSPA EV-DO WWAN mini module 531993-001
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Removal and replacement procedures
Reverse this procedure to install the WWAN module. 
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Removal and replacement procedures
RTC battery

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

Remove the RTC battery:

1. Position the computer with the front toward you.

2. Disconnect the RTC battery cable 1 from the system board.

3. Slide the RTC battery 2 directly back to remove it.

Reverse this procedure to install the RTC battery.

Description Spare part number

RTC battery 580055-001
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Removal and replacement procedures
Expansion memory module

Before removing the expansion memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

Remove the expansion memory module:

✎ 1024-MB primary memory is included on the system board. Expansion memory is customer- 
accessible/upgradable and is located in the accessory compartment.

1. Pull away the retention clips 1 on each side of the memory module to release the memory module. (The 
memory module tilts up.)

Ä
CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch the components on the memory 
module.

2. Grasp the edge of the memory module 2, and then pull it out of the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory 
module slot.

Description Spare part number

4096-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion 518754-002

4096-MB expansion memory module (1333-MHz, DDR3), for use with the HP Pavilion in systems 
that include a WWAN module 

581754-001

2048-MB (1333-MHz, DDR2) 580017-001

2048-MB (1333-MHz, DDR2), for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module

580017-002

2048-MB (1333-MHz, DDR3), for use with the HP Pavilion in systems that include a WWAN module 591374-001

1024-MB (1333-MHz, DDR2) 580016-001

1024-MB (1333-MHz, DDR2), for use with the HP Mini and Compaq Mini in systems that include a 
WWAN module

580016-002

1024-MB (1333-MHz, DDR2), for use with the HP Pavilion in systems that include a WWAN module 591373-001
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Removal and replacement procedures
Reverse this procedure to install an expansion memory module.
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Removal and replacement procedures
Hard drive

✎ The hard drive spare part kit includes a hard drive connector and hard drive bracket.

Before removing the hard drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Disconnect the hard drive connector 1.

3. Grasp the Mylar tab 2 in the hard drive bay, and then lift it up at an angle.

Description Spare part number

500-GB, 5400-rpm for use with HP Pavilion 584512-001

500-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591372-001

320-GB, 5400-rpm 580020-001

320-GB, 5400-rpm, for use HP Mini and Compaq Mini in systems that include a WWAN module 580020-002

320-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591371-001

250-GB, 5400-rpm 580019-001

250-GB, 5400-rpm, for use with the HP Mini and Compaq Mini in systems that include a WWAN 
module

580019-002

250-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591370-001

160-GB, 7200-rpm 591250-001

160-GB, 5400-rpm 580018-001

160-GB, 5400-rpm, for use with the HP Mini and Compaq Mini in systems that include a WWAN 
module

580018-002

160-GB, 5400-rpm, for use with the HP Pavilion in systems that include a WWAN module 591369-001

80-GB solid state drive (SSD) 584513-001
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Removal and replacement procedures
4. Remove the hard drive 3 from the hard drive bay. 
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Removal and replacement procedures
5. If it is necessary to replace the hard drive bracket or connector, follow these steps:

a. Disconnect the hard drive connector 1 from the hard drive.

b. Remove the 4 isolators 2 from the 4 corners of the hard drive bracket.

c. Remove the 4 Phillips PM3.0×4.0 screws 3 that secure the hard drive bracket to the hard drive.

d. Lift the bracket 4 straight up to remove it from the hard drive. 

Reverse this procedure to reassemble and install the hard drive. 
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Removal and replacement procedures
Keyboard

✎ The keyboard spare part kit includes a keyboard cable.

Description Spare part number

For use in Belgium 580030-A41

For use in the Czech Republic 580030-221

For use in Demark 580030-DH1

For use in France 580030-051

For use with the HP Mini and Compaq Mini in French Canada 580030-121

For use in Germany 580030-041

For use in Greece 580030-DJ1

For use in Hungary 580030-211

For use in Israel 580030-BB1

For use in Italy 580030-061

For use in Japan 580030-291

For use in the Netherlands 580030-B31

For use in Portugal 580030-131

For use in Russia 580030-251

For use in Saudi Arabia 580030-171

For use in South Korea 280030-AD1

For use in Spain 580030-071

For use in Switzerland 580030-BG1

For use in Taiwan 580030-AB1

For use in Thailand 580030-281

For use in Turkey 580030-141

For use in the United Kingdom 580030-031

For use in the United States 580030-001
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Removal and replacement procedures
Before removing the keyboard, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Remove the 4 Phillips PM2.0×7.0 screws that secure the keyboard to the computer.
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Removal and replacement procedures
3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the rear edge 1 and then the left edge 2 of the keyboard until it rests at an angle.

6. Slide the keyboard 3 back until it rests on the display.

7. Release the zero insertion force (ZIF) connector 1 to which the keyboard cable is attached, and then 
disconnect the keyboard cable 2 from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Removal and replacement procedures
Top cover

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Remove the keyboard (see “Keyboard” on page 4-21).

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the 2 Phillips PM2.0×12.0 screws 1 and the 3 Phillips PM2.0×7.0 screws 2, located under the rubber 
device feet, that secure the top cover to the base enclosure.

Description Spare part number

Top cover (includes TouchPad button board and cable, and TouchPad board and cable) 580057-001
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Removal and replacement procedures
3. Turn the computer right-side up, with the front toward you and the display open as far as possible.

4. Release and disconnect the following low insertion force (LIF) connector cables from the system board:

a. Power button board cable 1

b. TouchPad cable 2

c. TouchPad button board cable 3

d. WLAN button cable 4

5. Remove the 4 Phillips PM2.0×7.0 screws that secure the top cover to the base enclosure.
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Removal and replacement procedures
6. Lift the rear edge 1 of the top cover until it detaches from the base enclosure.

7. Remove the top cover 2 by lifting it straight up.

Reverse this procedure to install the top cover. 
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Removal and replacement procedures
Wireless button board

Before removing the wireless button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Remove the keyboard (see “Keyboard” on page 4-21).

8. Remove the top cover (see “Top cover” on page 4-24).

Remove the wireless button board:

1. Turn the top cover upside down, with the front toward you.

2. Remove the Phillips PM2.0×4.0 screw 1 that secures the wireless button board to the top cover.

3. Remove the wireless button board 2.

Reverse this procedure to install the wireless button board.

Description Spare part number

Wireless button board (includes cable) 580060-001
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Removal and replacement procedures
Power button board

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Remove the keyboard (see “Keyboard” on page 4-21).

8. Remove the top cover (see “Top cover” on page 4-24).

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.

2. Remove the Phillips PM2.0×4.0 screw 1 that secures the power button board to the top cover.

3. Remove the power button board 2.

Reverse this procedure to install the power button board.

Description Spare part number

Power button board (includes cable) 580058-001
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Removal and replacement procedures
Speakers

Before removing the speakers, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Remove the keyboard (see “Keyboard” on page 4-21).

8. Remove the top cover (see “Top cover” on page 4-24).

Remove the speakers:

1. Turn the computer right-side up, with the front toward you and the display open as far as possible.

2. Disconnect the speaker cable 1 from the system board.

3. Remove the 2 Phillips PM2.0×7.0 screws 2 that secure the speaker assembly to the base enclosure.

4. Remove the speaker assembly 3.

Reverse this procedure to install the speakers.

Description Spare part number

Speakers (include cables) 580064-001
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Removal and replacement procedures
Digital media assembly

Before removing the digital media assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Remove the keyboard (see “Keyboard” on page 4-21).

8. Remove the top cover (see “Top cover” on page 4-24).

Remove the digital media assembly:

1. Turn the computer right-side up, with the front toward you and the display open as far as possible.

2. Disconnect the LIF digital media assembly cable 1.

3. Remove the Phillips PM2.0×4.0 screw 2 that secures the digital media assembly to the base enclosure.

4. Remove the digital media assembly 3.

Reverse this procedure to install the digital media assembly.

Description Spare part number

Digital media assembly (includes cable) 580065-001
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Removal and replacement procedures
Display assembly

Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the accessory compartment cover (see “WLAN module” on page 4-9).

6. Remove the hard drive (see “Hard drive” on page 4-18).

7. Disconnect the wireless antenna cables from the WLAN module (see “WLAN module” on page 4-9) and 
WWAN module (see “WWAN module” on page 4-13).

8. Remove the keyboard (see “Keyboard” on page 4-21).

9. Remove the top cover (see “Top cover” on page 4-24).

Description Spare part number

11.6-in (1366 × 768) HD, BrightView, LED display assembly (includes webcam, microphone, 2 WLAN antenna transceivers 
and cables, nameplate, and logo):

Display assembly with 2 WWAN antennas for use with the HP Mini 580006-001

Display assembly for use with the HP Mini 580007-001

Display assembly with 2 WWAN antennas for use with the Compaq Mini 580011-001

Display assembly with 2 WWAN antenna for use with the white-colored HP Pavilion 588690-001

Display assembly with 2 WWAN antenna for use with the black-colored HP Pavilion 588689-001

Display bezel (includes hinge covers):

For use only with the HP Mini 580010-001

For use only with the Compaq Mini 580015-001

For use only with the HP Pavilion 587312-001

Display panel 580001-001

Display panel/webcam/microphone cable 580003-001

Webcam module 580004-001

Wireless antenna cables 580005-001

Display enclosure (includes hinge and hinge brackets):

For use with the HP Mini and HP Pavilion 580009-001

For use with the HP Mini and HP Pavilion that includes WWAN 580008-001

For use with the Compaq Mini 580013-001
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Removal and replacement procedures
Remove the display assembly:

1. Turn the computer display-side up, with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the display panel/webcam/microphone cable 1 from the system board.

4. Remove the wireless antenna cables from the clips 2 and routing channel built into the base enclosure.
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Removal and replacement procedures
ÄCAUTION: Support the display assembly when removing the following screws. Failure to support the display 
assembly can result in damage to the display assembly and other computer components.

5. Remove the 4 Phillips PM2.0×7.0 screws 1 that secure the display assembly to the base enclosure.

6. Lift the display assembly 2 straight up and remove it.

7. If it is necessary to replace the display bezel or any of the display assembly internal components:

a. Remove the hinge covers 1. 

b. Flex the inside edges of the top edge 2, the left and right sides 3, and the bottom edge 4 of the display 
bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel 5. 
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Removal and replacement procedures
8. If it is necessary to replace the webcam module:

a. Disconnect the display panel/webcam/microphone cable 1 from the webcam module.

b. Remove the webcam module 2. 

9. If it is necessary to replace the display panel:

a. Remove the 6 Phillips PM2.0×4.0 screws 1 that secure the display hinge brackets to the display panel.

b. Remove the display hinge brackets 2.
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Removal and replacement procedures
c. Remove the 4 Phillips PM2.0×4.0 screws 1 that secure the display panel to the display enclosure.

d. Remove the display panel 2.

10. If it is necessary to replace the display panel/webcam/microphone cable:

a. Turn the display panel upside down, with the bottom edge toward you.

b. Lift the adhesive support strip 1 that secures the display panel/webcam/microphone cable to the display 
panel.

c. Disconnect the display panel/webcam/microphone cable 2 from the connector on the back of the display 
panel, and remove the display panel/webcam/microphone cable.
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Removal and replacement procedures
11. If it is necessary to replace the wireless antenna transceivers and cables:

a. Detach the wireless antenna transceivers 1 from the display enclosure. (The transceivers are attached to the 
enclosure with double-sided tape.)

b. Release the wireless antenna cables 2 from the clips and routing channel built into the left side of the 
display enclosure, and remove the wireless antenna transceivers and cables.

Reverse this procedure to reassemble and install the display assembly.
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Removal and replacement procedures
Multi board

Before removing the multi board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Accessory compartment cover (see “WLAN module” on page 4-9)

b. Hard drive (see “Hard drive” on page 4-18)

c. Keyboard (see “Keyboard” on page 4-21)

d. Top cover (see “Top cover” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-31)

Remove the multi board:

1. Disconnect the multi board cable 1 from the system board.

2. Remove the 2 Phillips PM2.0×5.0 screws 2 that secure the multi board to the base enclosure.

3. Remove the multi board 3 and cable.

Reverse this procedure to install the multi board.

Description Spare part number

Multi board (includes USB and RJ-45 ports, and cable) 580066-001

Multi board for use the with the HP Pavilion (includes USB and RJ-45 ports, and cable) 591994-001
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Removal and replacement procedures
System board

Before removing the system board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components:

a. Accessory compartment cover (see “WLAN module” on page 4-9)

b. Hard drive (see “Hard drive” on page 4-18)

c. Keyboard (see “Keyboard” on page 4-21)

d. Top cover (see “Top cover” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-31)

When replacing the system board, be sure that the following additional components are removed from the defective 
system board and installed on the replacement system board: 

■ SIM (see “SIM” on page 4-8)

■ WLAN module (see “WLAN module” on page 4-9)

■ RTC battery (see “RTC battery” on page 4-15)

■ Expansion memory module (see “Expansion memory module” on page 4-16)

■ WWAN module (see “WWAN module” on page 4-13)

■ Power connector (see “Power connector” on page 4-41)

■ Fan (see “Fan” on page 4-42)

■ Heat sink (see “Heat sink assembly” on page 4-43)

Description Spare part number

System board (includes processor, 1024-MB base memory, and replacement thermal material):

Includes Intel Atom N280 1.66-GHz processor, 512-KB Level 2 cache, 667-MHz front-side 
bus (FSB) for use with the HP Mini and Compaq Mini

580000-001

Includes Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus (FSB) 
for use with the HP Mini and Compaq Mini

579999-001

Includes Intel Pentium 1.3-GHz processor, 2048-KB Level 2 cache, 800-MHz FSB for use with HP 
Pavilion

581751-001

Includes Intel Pentium 1.2-GHz processor, 1024-KB Level 2 cache, 800-MHz FSB for use with the 
HP Pavilion

581750-001
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Removal and replacement procedures
Remove the system board:

1. Remove the Phillips PM2.0×7.0 screw 1 that secures the power connector to the base enclosure.

2. Release the power connector 2 from the base enclosure.

3. Remove the Phillips PM2.0×4.0 screw that secures the system board to the base enclosure.
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Removal and replacement procedures
4. Lift the right side of the system board 1 until it rests at an angle.

5. Remove the system board 2 by sliding it away from the base enclosure at an angle.

Reverse this procedure to install the system board.
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Removal and replacement procedures
Power connector

Before removing the power connector, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Accessory compartment cover (see “Keyboard” on page 4-21)

b. Hard drive (see “Hard drive” on page 4-18)

c. Keyboard (see “Keyboard” on page 4-21)

d. Top cover (see “Top cover” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-31)

f. System board (see “System board” on page 4-38)

Remove the power connector:

1. Disconnect the power connector cable from the system board.

2. Remove the power connector.

Reverse this procedure to install the power connector.

Description Spare part number

Power connector (includes cable) 591851-001
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Removal and replacement procedures
Fan

Before removing the fan, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Accessory compartment cover (see “Keyboard” on page 4-21)

b. Hard drive (see “Hard drive” on page 4-18)

c. Keyboard (see “Keyboard” on page 4-21)

d. Top cover (see “Top cover” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-31)

f. System board (see “System board” on page 4-38)

Remove the fan:

1. Disconnect the fan cable 1 from the system board.

2. Remove the 2 Phillips PM2.0×4.0 screws 2 that secure the fan to the system board.

3. Remove the fan 3.

Reverse this procedure to install the fan.

Description Spare part number

Fan (includes cable) 580061-001
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Removal and replacement procedures
Heat sink assembly

✎ To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, battery fast 
charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side 
of the computer. 

Before removing the heat sink assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Accessory compartment cover (see “Keyboard” on page 4-21)

b. Hard drive (see “Hard drive” on page 4-18)

c. Keyboard (see “Keyboard” on page 4-21)

d. Top cover (see “Top cover” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-31)

f. System board (see “System board” on page 4-38)

g. Fan (see “Fan” on page 4-42)

Description Spare part number

Heat sink assembly (includes replacement thermal material)

For use with the HP Mini and Compaq Mini 580059-001

For use with the HP Pavilion 580058-001
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Removal and replacement procedures
Remove the heat sink assembly:

1. Following the 1, 2, 3, 4, 5 sequence stamped into the heat sink assembly, loosen the 5 Phillips PM2.0×6.0 
captive screws 1 that secure the fan and heat sink assembly to the system board.

✎Due to the adhesive quality of the thermal material located between the heat sink and system board 
components, it may be necessary to move the heat sink from side to side to detach it.

✎ Step 2 applies to HP Mini and Compaq Mini computer models. See Step 3 for HP Pavilion computer models.

2. Remove the heat sink assembly 2.

✎ The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board each time 
the fan and heat sink are removed:
■ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.
■ Thermal pads are used on the MCP79 chip 3 and the heat sink section 4 that services it.
Replacement thermal material is included with all system board and heat sink assembly spare part kits.
4–44 Maintenance and Service Guide



Removal and replacement procedures
✎ Step 3 applies to HP Pavilion computer models. See Step 2 for HP Mini and Compaq Mini Computer models.

3. Remove the heat sink assembly 2.

✎ The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board each time 
the fan and heat sink are removed:
■ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.
■ Thermal pads are used on the Intel GS45 (8W) chip 3 and the heat sink section 4 that services it. 
■ Thermal pads are used on the Southbridge ICH9M chip 5 and the heat sink section 6 that services it.
Replacement thermal material is included with all system board and heat sink assembly spare part kits.

Reverse this procedure to install heat sink.
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5
Setup Utility

Starting Setup Utility
Setup Utility is a ROM-based information and customization utility that can be used even when your operating 
system is not working.

The utility reports information about the computer and provides settings for startup, security, and other preferences.

To start Setup Utility:

» Open Setup Utility by turning on or restarting the computer, and then pressing esc while the “Press The ESC 
Key for Startup Menu” message is displayed in the lower-left corner of the screen.

Using Setup Utility

Changing the language of Setup Utility

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not already 
running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer, and then pressing f10 while the “F10 = BIOS Setup 
Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving Changes, and then 
press enter.

Your change goes into effect immediately.

Navigating and selecting in Setup Utility

Because Setup Utility is not operating system-based, it does not support the TouchPad. Navigation and selection 
are by keystroke.

■ To choose a menu or a menu item, use the arrow keys.

■ To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the arrow keys 
or f5 or f6.

■ To select an item, press enter.

■ To close a text box or return to the menu display, press esc.

■ To display additional navigation and selection information while Setup Utility is open, press f1.
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Setup Utility
Displaying system information

The following procedure explains how to display system information in Setup Utility. If Setup Utility is not open, 
begin at step 1. If Setup Utility is open, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer, and then pressing f10 while the “F10 = BIOS Setup 
Options” message is displayed in the lower-left corner of the screen.

2. Select the Main menu. System information such as the system time and date, and identification information 
about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit Discarding 
Changes, and then press enter.

Restoring factory settings in Setup Utility

The following procedure explains how to restore the Setup Utility default settings. If Setup Utility is not already 
running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer, and then pressing f10 while the “F10 = BIOS 
Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving Changes, and 
then press enter.

The Setup Utility default settings go into effect when the computer restarts.

✎ Your password settings, language settings, security settings, and hard drive mode are not changed when you 
restore the factory settings.

Exiting Setup Utility

You can exit Setup Utility with or without saving changes.

■ To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the arrow keys to 
select Exit > Exit Saving Changes, and then press enter.

■ To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the arrow keys to 
select Exit > Exit Discarding Changes, and then press enter.

After either choice, the computer restarts in your operating system.
5–2 Maintenance and Service Guide



Setup Utility
Setup Utility menus
The menu tables in this section provide an overview of Setup Utility options.

✎ Some of the Setup Utility menu items listed in this chapter may not be supported by your computer.

Main menu

Security menu

Diagnostics menu

Select To do this

System Information ■ View and change the system time and date.

■ View identification information about the computer.

■ View specification information about the processor, memory size, and 
system BIOS.

Select To do this

Administrator Password Enter, change, or delete an administrator password.

Power-On Password Enter, change, or delete a power-on password.

Select To do this

Primary Hard Disk Self Test 
(select models only)

Run a comprehensive self-test on the hard drive.

Memory test Run a diagnostic test on the system memory.
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Setup Utility
System Configuration menu

Select To do this

Language support Change the Setup Utility language.

Virtualization Technology 
(select models only)

Enable/disable Virtualization Technology.

LAN power saving Enable/disable the LAN power saving option.

Boot Options Set the following boot options:
■ POST (power-on self test) f10 and f12 Delay (sec.): Set the delay for the f10 

and f12 functions of Setup Utility in intervals of 5 seconds each (0, 5, 10, 15, 
20).

■ CD-ROM Boot: Enable/disable boot from CD/DVD ROM drive.

■ Floppy Boot: Enable/disable boot from diskette drive.

■ Internal Network Adapter boot: Enable/disable boot from Internal Network 
Adapter.

■ Boot order - Set the boot order for:

❐ Internal hard drive (select models only)

✎ Internal hard drive boot capability is disabled if an exclamation mark is 
displayed.

❐ USB Floppy
❐ USB Hard drive
❐ USB CD/DVD ROM Drive
❐ Network adapter
5–4 Maintenance and Service Guide



6
Specifications

Computer specifications

Metric U.S.

Dimensions

Length 22.78 cm 8.97 in

Width 32.49 cm 12.79 in

Height (front to back) 2.73 to 3.68 cm 1.07 to 1.45 in

Weight 1.9 kg 4.19 lbs

Input power

Operating voltage 18.5Vdc @ 3.5A = 65W

Operating current 3.5A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.
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Specifications
11.6-in display specifications

Metric U.S. 

Dimensions

Height 17.8 cm 7.0 in

Width 28.4 cm 11.2 in

Diagonal 33.6 cm 13.3 in

Number of colors Up to 16.8 million

Contrast ratio 400:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.1875 × 0.1875 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)
6–2 Maintenance and Service Guide



Specifications
Hard drive specifications

320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 2.0 ms 2.0 ms

Average 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms

Logical blocks 625,142,448 488,397,168 312,581,808

Disc rotational speed 5400 rpm 5400 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.
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Specifications
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 
specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CD EXTRA, 
Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM 
(DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, 
DVD+R, DVD+RW, DVD-RAM

CD-R, CD-RW, DVD+R, 
DVD+RW, DVD-R, DVD-RW, 
DVD-RAM, LightScribe

Interface SATA

Access time CD DVD

Random < 150 ms < 160 ms

Max data transfer rate 

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

8x DVD+RW 10,800 KB/sec

8X DVD-R 10,800 KB/sec

6X DVD-RW 8,100 KB/sec

4X DVD-R Dual Layer 5,400 KB/sec

4X DVD+R Dual Layer 5,400 KB/sec

5X DVD-RAM 6,750 KB/sec

Max media capacity (read) 8.5 GB

Max media capacity (write) 8.5 GB

Transport Tray loading
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Specifications
Blu-ray ROM with LightScribe DVD±R/RW SuperMulti Double-Layer Drive 
specifications

Applicable disc Read: Write: 

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CD-EXTRA, 
Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM 
(DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, 
DVD+R, DVD+RW. DVD-RAM, 
BD-ROM, BD-R, BD-RE

CD-R, CD-RW, DVD+R, 
DVD+R(9), DVD+RW, DVD-R, 
DVD-R(9), DVD-RW, 
DVD-RAM, LightScribe

Interface SATA

Access time CD DVD BD

Random < 190 ms < 190 ms < 230 ms

Max data transfer rate 

24X CD-ROM 3,600 KB/sec 

8X DVD-ROM 10,800 KB/sec 

4X BD-ROM 18,000 KB/sec

16X CD-R 1,200 KB/sec

10X CD-RW 1,500 KB/sec 

8X DVD+R 10,800 KB/sec

8X DVD+RW 10,800 KB/sec

8X DVD-R 10,800 KB/sec

6X DVD-RW 8,100 KB/sec

4X DVD+R Dual Layer 5,400 KB/sec

4X DVD-R Dual Layer 5,400 KB/sec

5X DVD-RAM 6,750 KB/sec

Max media capacity (read) 50.0 GB

Max media capacity (write) 8.5 GB

Transport Tray loading
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Specifications
System DMA specifications

System memory map specifications

Hardware DMA System function 

DMA0 Not applicable 

DMA1* Not applicable 

DMA2* Not applicable 

DMA3 Not applicable 

DMA4 Direct memory access controller 

DMA5* Not applicable 

DMA6 Not assigned 

DMA7 Not assigned 

*ExpressCard controller can use DMA 1, 2, or 5. 

Size Memory address System function 

640 KB 00000000–0009FFFF Base memory 

128 KB 000A0000–000BFFFF Video memory 

64 KB 000C0000–000CFFFF Video BIOS 

64 KB 000E8000–000FFFFF System BIOS 

00100000–XFFFFFFF Extended memory (based on 
memory installed)

(X+1)0000000–FEDFFFFF PCI bus

FED00000–FED003FF High-precision event timer

FEE01000–FFFFFFFF PCI bus 
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Specifications
System interrupt specifications

Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-key or Microsoft® natural keyboard

IRQ8 System CMOS/real-time clock

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ16 Intel ICH9 family USB universal host controller 2937
Mobile Intel 4 Series express chipset family

IRQ17* High-definition audio controller
Intel ICH9 family USB universal host controller 2938 
Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

IRQ18 Intel ICH9 family USB universal host controller 2939
Intel ICH9 family USB universal host controller 2936

IRQ19 Intel ICH9 family USB2 enhanced controller 293C

IRQ20 Intel ICH9 family USB2 enhanced controller 293A
Intel ICH9 family USB universal host controller 2934

IRQ21 Intel ICH9M-E/M SATA AHCI controller

IRQ22 Intel ICH9 family USB universal host controller 2935

*Default configuration; other possible audio configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none. 

✎ ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial 
port may assert IRQ3 or IRQ4. 

✎ For operating systems after Windows 2000, APIC (Advanced programming interrupt controller) is used.
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Specifications
System I/O address specifications

I/O address (hex) System function (shipping configuration) 

000–01F DMA controller

020–021 Program interrupt controller

024–025 Program interrupt controller

028–029 Program interrupt controller

02C–03D Program interrupt controller

02E–02F Motherboard resources

030–031 Program interrupt controller

034–035 Program interrupt controller

038–039 Program interrupt controller

03C–03D Program interrupt controller

040–043 System timer

04E–04F Motherboard resources

050–053 System timer

060 Standard 101-/102-key or Microsoft natural keyboard

061 Motherboard resources

062 Microsoft ACPI-compliant embedded controller

063 Motherboard resources

064 Standard 101-/102-key or Microsoft natural keyboard

065 Motherboard resources

066 Microsoft ACPI-compliant embedded controller

067 Motherboard resources

070 Motherboard resources

071–077 System CMOS/real-time clock

080 Motherboard resources

081–091 Direct memory access controller

092 Motherboard resources

093–09F Direct memory access controller

0A0–0A1 Program interrupt controller

0A4–0A5 Program interrupt controller

0A8–0A9 Program interrupt controller

0AC–0AD Program interrupt controller

0B0–0B1 Program interrupt controller

0B2–0B3 Motherboard resources

0B4–0B5 Program interrupt controller

0B8–0B9 Program interrupt controller

0BC–0BD Program interrupt controller

(Continued)
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Specifications
0C0–0DF Direct memory access controller

0F0–0F0 Numeric data processor

0200–027F Motherboard resources

3B0–3BB Mobile Intel 4 Series express chipset family

3C0–3DF Mobile Intel 4 Series express chipset family

400–47F Motherboard resources

4D0–4D1 Programmable interrupt controller

500–57F Motherboard resources

1000–1003 Motherboard resources

1010–101F Motherboard resources

2000–20FF Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

2000–2FFF ICH9 family PCI express root port6-294A

3000–4FFF ICH9 family PCI express root port5-2948

5000–6FFF ICH9 family PCI express root port3-2944

7000–701F ICH9M-E/M SATA AHCI controller

7020–703F ICH9 family USB universal host controller 2936

7040–705F ICH9 family USB universal host controller 2935

7060–707F ICH9 family USB universal host controller 2934

7080–709F ICH9 family USB universal host controller 2939

70A0–70BF ICH9 family USB universal host controller 2938

70C0–70DF ICH9 family USB universal host controller 2937

70E0–70E7 ICH9M-E/M SATA AHCI controller

70E8–70EF ICH9M-E/M SATA AHCI Controller

70F0–70F7 Mobile Intel 4 Series express chipset family

70F8–70FB ICH9M-E/M SATA AHCI controller

70FC–70FF ICH9M-E/M SATA AHCI controller

EF80–EF9F Motherboard resources

FE00–FE0F Motherboard resources

FE80–EF8F Motherboard resources

FFFF Motherboard resources

I/O address (hex) System function (shipping configuration) 
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7
Screw listing

This chapter provides specification and reference information for the screws used in the computer. The screws 
listed in this chapter are available in the Screw Kit, spare part number 580063-001. 
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Screw listing
Phillips PM2.0×4.0 screw

 

Where used: One screw that secures the WLAN module to the system board

Where used: 2 screws that secure the WWAN module to the system board

Color Quantity Length Thread Head diameter 

Black 18 4.0 mm 2.0 mm 4.5 mm
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Screw listing
Where used: One screw that secures the wireless button board to the top cover

Where used: One screw that secures the power button board to the top cover

Where used: One screw that secures the digital media assembly to the base enclosure
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Screw listing
Where used: 6 screws that secure the display hinge brackets to the display enclosure

Where used: 4 screws that secure the display panel to the display enclosure

Where used: 2 screws that secure the fan to the system board (HP Mini and Compaq Mini models)
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Screw listing
Where used: 2 screws that secure the fan to the system board (HP Pavilion models)
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Screw listing
Phillips PM2.0×5.0 screw

Where used: 2 screws that secure the multi board to the base enclosure

Color Quantity Length Thread Head diameter 

Black 2 5.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×6.0 captive screw

Where used: 2 captive screws that secure the accessory compartment cover to the computer (screws are secured to 
the cover by C-clips)

Color Quantity Length Thread Head diameter 

Black 7 6.0 mm 2.0 mm 5.0 mm
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Screw listing
Where used: 5 captive screws that secure the heat sink to the system board (screws are secured to the heat sink by 
C-clips) (HP Mini and Compaq Mini models)
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Screw listing
Where used: 5 captive screws that secure the heat sink to the system board (screws are secured to the heat sink by 
C-clips) (HP Pavilion models)
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Screw listing
Phillips PM2.0×7.0 screw

 

Where used: 4 screws that secure the keyboard to the base enclosure

Where used: 3 screws that secure the top cover to the base enclosure

Color Quantity Length Thread Head diameter 

Black 19 7.0 mm 2.0 mm 4.5 mm
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Screw listing
Where used: 4 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the speaker assembly to the base enclosure
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Screw listing
Where used: 4 screws that secure the display assembly to the base enclosure

Where used: One screw that secures the power connector to the base enclosure

Where used: 1 screw that secures the system board to the base enclosure
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Screw listing
Phillips PM2.0×12.0 screw

Where used: 2 screws that secure the top cover to the base enclosure

Color Quantity Length Thread Head diameter 

Black 2 12.0 mm 2.0 mm 5.0 mm
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Screw listing
Phillips PM3.0×4.0 screw

 

Where used: 4 screws that secure the hard drive bracket to the hard drive

Color Quantity Length Thread Head diameter 

Silver 4 4.0 mm 3.0 mm 5.0 mm
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Backup and recovery

Backup and recovery in Windows 7

Overview

Recovery after a system failure is as complete as your most current backup. HP recommends that you create 
recovery discs immediately after software setup. As you add new software and data files, you should continue to 
back up your system on a regular basis to maintain a reasonably current backup.

Tools provided by the operating system and HP Recovery Manager software are designed to help you with the 
following tasks for safeguarding your information and restoring it in case of a system failure:

■ Creating a set of recovery discs (Recovery Manager software feature). Recovery discs are used to start up 
(boot) your computer and restore the operating system and software programs to factory settings in case of 
system failure or instability.

■ Backing up your information regularly to protect your important system files.

■ Creating system restore points (operating system feature). System restore points allow you to reverse 
undesirable changes to your computer by restoring the computer to an earlier state.

■ Recovering a program or driver (Recovery Manager software feature). This feature helps you reinstall a 
program or driver without performing a full system recovery.

■ Performing a full system recovery (Recovery Manager software feature). With Recovery Manager, you can 
recover your full factory image if you experience system failure or instability. Recovery Manager works from a 
dedicated recovery partition (select models only) on the hard drive or from recovery discs you create.

✎ Computers with a solid-state drive (SSD) may not have a recovery partition. Recovery discs have been included 
for computers that do not have a partition. Use these discs to recover your operating system and software. To 
check for the presence of a recovery partition, select Start, right-click Computer, click Manage, and then click 
Disk Management. If the partition is present, an HP Recovery drive is listed in the window.
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Backup and recovery
Creating recovery discs

HP recommends that you create recovery discs to be sure that you can restore your system to its original factory 
state if you experience serious system failure or instability. Create these discs after setting up the computer for the 
first time.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only one set of 
recovery discs.

✎ If your computer does not include an internal optical drive, you can use an optional external optical drive 
(purchased separately) to create recovery discs, or you can purchase recovery discs for your computer from the 
HP Web site.

Note the following guidelines before creating recovery discs:

■ You will need high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CD-R discs. All these discs are 
purchased separately. DVDs and BDs have a much higher capacity than CDs. If you use CDs, up to 20 discs 
may be required, whereas only a few DVDs or BDs are required.

✎ Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE (rewritable Blu-ray) discs, 
are not compatible with the Recovery Manager software.

■ The computer must be connected to AC power during this process.

■ Only one set of recovery discs can be created per computer.

■ Number each disc before inserting it into the optical drive.

■ If necessary, you can exit the program before you have finished creating the recovery discs. The next time you 
open Recovery Manager, you will be prompted to continue the disc creation process.

To create a set of recovery discs:

1. Select Start > All Programs > Recovery Manager > Recovery Disc Creation.

2. Follow the on-screen instructions.

Backing up your information

As you add new software and data files, you should back up your system on a regular basis to maintain a 
reasonably current backup. Back up your system at the following times:

■ At regularly scheduled times

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored

■ Before you add or modify hardware or software

Note the following when backing up:

■ Create system restore points using the Windows® System Restore feature, and periodically copy them to disc.

■ Store personal files in the Documents library and back up this folder periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings. The screen 
shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document, follow these steps:

1. Display the screen.

2. Copy the screen:
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Backup and recovery
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

4. Save the document.

■ You can back up your information to an optional external hard drive, a network drive, or discs.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD-R, or DVD±RW. The discs you use will depend on the type of optical drive installed in your 
computer.

✎ DVDs store more information than CDs, so using them for backup reduces the number of recovery discs 
required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

Using Windows Backup and Restore

To create a backup using Windows Backup and Restore, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

✎ The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

✎ Windows includes the User Account Control feature to improve the security of your computer.

✎ You may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support for more information.

Using system restore points

When you back up your system, you are creating a system restore point. A system restore point allows you to save 
and name a snapshot of your hard drive at a specific point in time. You can then recover back to that point if you 
want to reverse subsequent changes made to your system.

✎ Recovering to an earlier restore point does not affect data files saved or e-mails created since the last restore 
point.

You also can create additional restore points to provide increased protection for your system files and settings.

When to create restore points
■ Before you add or extensively modify software or hardware

■ Periodically, whenever the system is performing optimally

✎ If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point
1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Under Protection Settings, select the disk for which you want to create a restore point.

5. Click Create.

6. Follow the on-screen instructions.

Restore to a previous date or time
To revert to a restore point (created at a previous date and time), when the computer was functioning optimally, 
follow these steps:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.

Performing a recovery

✎ You can recover only files that you have previously backed up. HP recommends that you use HP Recovery 
Manager to create a set of recovery discs (entire drive backup) as soon as you set up your computer.

Recovery Manager software allows you to repair or restore the system if you experience system failure or 
instability. Recovery Manager works from recovery discs or from a dedicated recovery partition (select models 
only) on the hard drive. However, if your computer includes a solid-state drive (SSD), you may not have a recovery 
partition. If that is the case, recovery discs have been included with your computer. Use these discs to recover your 
operating system and software.

✎ Windows has its own built-in repair features, such as System Restore. If you have not already tried these 
features, try them before using Recovery Manager. 

✎ Recovery Manager recovers only software that was preinstalled at the factory. Software not provided with this 
computer must be downloaded from the manufacturer’s Web site or reinstalled from the disc provided by the 
manufacturer.

Recovering from the recovery discs
To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.
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Recovering from the dedicated recovery partition (select models only)

✎ Computers with an SSD may not have a recovery partition. If the computer does not have a recovery partition, 
you will not be able to recover using this procedure. Recovery discs have been included for computers that do 
not have a partition. Use these discs to recover your operating system and software.

On some models, you can perform a recovery from the partition on the hard drive, accessed by pressing either the 
Start button or f11. This restores the computer to its factory condition.

To restore the system from the partition, follow these steps:

1. Access Recovery Manager in either of the following ways:

Select Start > All Programs > Recovery Manager > Recovery Manager.

– or –

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 
displayed at the bottom of the screen. Then, press f11 while the “Press <F11> for recovery” message is 
displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.

Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.
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■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.
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Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in 
Help and Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system, software, and 
drivers. Software, drivers, and updates not installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9
Connector pin assignments

Audio-out (headphone)/Audio-in (microphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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Connector pin assignments
External monitor

 
Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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Connector pin assignments
HDMI

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield

3 TMDS data 2-

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0-

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect
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Connector pin assignments
RJ-45 (network)

Universal Serial Bus

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
9–4 Maintenance and Service Guide



10
Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC, 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions
The following requirements are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.

4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.
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Recycling
5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

Maintenance and Service Guide 11–3



Recycling
11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging 
this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part numbers 3–10, 3–11
antennas

disconnecting 4–12, 4–13
locations 2–2

audio, product description 1–3
audio-in jack, connector pinout 9–1
audio-out jack, connector pinout 9–1

B
backing up files 8–2
base enclosure, spare part number 3–4, 3–15
battery

removal 4–7
spare part numbers 3–8, 3–14, 4–7

battery bay 2–10
BIOS administrator password 5–3
Bluetooth module, spare part number 3–4, 3–13, 3–15
Blu-ray ROM DVD±R/RW SuperMulti Double-Layer 

Drive
precautions 4–2
spare part number 3–10, 3–14

Blu-ray ROM with LightScribe DVD±R/RW 
SuperMulti DL Drive, specifications 6–5

boot options 5–4
boot order 5–4
bottom components 2–10
buttons

power 2–3
TouchPad 2–6
wireless 2–3

C
Cable Kit, spare part number 3–4, 3–16
cables, service considerations 4–1
caps lock light 2–5
chipset, product description 1–1
components

bottom 2–10
buttons 2–3
display 2–1
front 2–7
keys 2–4
left-side 2–9
lights 2–5

pointing device 2–6
right-side 2–8
top 2–3

computer feet
locations 4–6
spare part number 4–6

computer specifications 6–1
connector pinout
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external monitor port 9–2
HDMI port 9–3
headphone jack 9–1
microphone jack 9–1
modem jack 9–4
monitor port 9–2
network jack 9–4
RJ-11 jack 9–4
RJ-45 jack 9–4
USB port 9–4

connectors, service considerations 4–1

D
Diagnostics menu 5–3
diskette drive, product description 1–3
display assembly

removal 4–31
spare part number 3–15
spare part numbers 3–3, 3–13, 4–31

display bezel
illustrated 3–9, 3–13, 4–31
removal 4–33
spare part numbers 3–9, 3–13, 3–14, 4–31

Display Cable Kit
illustrated 3–9, 3–13, 4–31
spare part numbers 3–9, 3–13, 4–31

display components
illustrated 2–1
recycling 11–1
spare part numbers 3–9

display enclosure
illustrated 3–9, 4–31
spare part numbers 3–9, 3–13, 3–14, 4–31

display hinges, removal 4–34
display inverter, removal 11–2
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Index
display panel cable
illustrated 3–9, 3–13, 4–31
removal 4–35
spare part numbers 3–9, 3–13, 4–31

display panel, product description 1–2
display switch 2–1
drive light 2–7
drives, boot order 5–4
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive
precautions 4–2
spare part number 3–10, 3–14
specifications 6–6

DVD-ROM Drive
precautions 4–2
specifications 6–6

E
electrostatic discharge 4–2
equipment guidelines 4–4
esc key 2–4
Ethernet, product description 1–3
external media card, product description 1–4
external monitor port

connector pinout 9–2
location 2–8

F
f11 recovery 8–4
fan

removal 4–43
spare part number 3–15, 4–43

feet
locations 4–6
spare part number 4–6

File menu 5–3
fn key 2–4
front components 2–7
function keys 2–4

G
graphics, product description 1–1
grounding equipment and methods 4–2

H
hard drive

precautions 4–2
product description 1–2
removal 4–18
spare part number 3–15
spare part numbers 3–8, 3–14, 3–16, 4–18
specifications 6–3

hard drive bay 2–10
hard drive bracket, removal 4–20

hard drive connector, removal 4–20
hard drive hardware kit,spare part numbers 3–14
hard drive recovery 8–4
HDMI port, connector pinout 9–3
headphone jack, connector pinout 9–1
heat sink

removal 4–43
spare part number 3–15
spare part numbers 4–43

hinges, removal 4–34

J
jacks

modem 2–9
network 2–8
RJ-11 2–9
RJ-45 2–8

K
key components 2–4
keyboard

product description 1–4
removal 4–21
spare part number 3–3, 3–14, 3–15, 4–21

keys
esc 2–4
fn 2–4
function 2–4
Windows applications 2–4
Windows logo 2–4

L
language, changing in Computer Setup 5–4
left-side components 2–9
light components 2–5
lights

caps lock 2–5
drive 2–7
power 2–5
webcam 2–1
wireless 2–5

M
memory module

removal 4–16
spare part numbers 3–4, 3–14, 3–16, 4–16

memory, product description 1–2
microphone

locations 2–1
product description 1–3

microphone jack, connector pinout 9–1
model name 3–1, 4–5
modem jack

connector pinout 9–4
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location 2–9
modem, product description 1–3
monitor port

connector pinout 9–2
location 2–8

multi board
spare part numbers 3–16

N
network cable, removal 4–43
network jack

connector pinout 9–4
location 2–8

O
operating system, product description 1–5
optical drive

precautions 4–2
product description 1–3
spare part numbers 3–10
specifications 6–5, 6–6

P
packing guidelines 4–3
passwords 5–3
plastic parts 4–1
Plastics Kit

contents 3–10
spare part number 3–4, 3–15

pointing device
components 2–6
illustrated 2–6
product description 1–4
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external monitor 2–8
monitor 2–8
product description 1–4
USB 2–8, 2–9

power button board
removal 4–38
spare part numbers 3–4, 3–15, 4–38

power connector 2–9
power connector cable, removal 4–38
power cord

set requirements 10–1
spare part numbers 3–10, 3–11

power light 2–5
power requirements, product description 1–4
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product description
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R
recovering information 8–4
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preliminaries 4–1
procedures 4–5

restoring factory settings 5–2
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connector pinout 9–4
location 2–9
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spare part number 3–4, 3–15, 4–15
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S
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screw listing 7–1
Security menu 5–3
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5–3
security, product description 1–5
service considerations 4–1
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Setup Utility

accessing 5–1
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removal 4–21
spare part numbers 4–21

system board
removal 4–38
spare part number 3–15
spare part numbers 3–4, 3–13, 4–38

System Configuration menu 5–4
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Universal Serial Bus (USB) port
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warranty period 3–1, 4–5
webcam 2–1
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spare part number 3–9, 3–13, 4–31

webcam, product description 1–3
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wireless light 2–5
wireless, product description 1–4
WLAN module

removal 4–9
spare part numbers 3–5, 3–11, 3–12, 3–13, 4–9
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spare part numbers 3–4, 4–13
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